Writing Tools

Wacky Web Tales - an online "madlib" tool GREAT for primary grades

Writing Fix - Interactive Writing Prompts

Read/write/think - Interactive digital activities (click the student materials link and then click the interactive links - there are many to choose from)

Mnemograph - collaborative, online Time Line tools

ToonDoo - Online comic strip creator – GOOD (and cheap)

kerpoof - 

 HYPERLINK "http://www.kerpoof.com/"
create original artwork, animated movies, and stories
pikikids.com – create 'comics' 
weboword.com – vocab visualizer
http://www.kwarp.com/portfolio/grammarninja.html

 HYPERLINK "http://www.kerpoof.com/"
  primary grammar site, good

Microsoft Word

Shortcut Keys Drawing Toolbar - Insert Clip Art, Speech/Thought Bubbles, Make lined Paper

Power of Color - Format>Background  

Power of Voice - Add insert sound object icon to Toolbar; View>Toolbars>Customize>Commands>Insert>Voice Comment, drag icon to toolbar. Tip: When you start to record, you have 60 seconds. If you record for longer than 60 seconds, click the red record button again.

Create note taking templates in Word

Use "Power of Color" within Word (background color, highlighting color and font color tools) to reinforce concepts, to determine salient points and for review

Use the "Organizational Chart" in the Diagram Gallery that is part of the Drawing Toolbar in Word to reinforce concepts and relationships which promotes learning.

In Word, press the Alt tab + mouse click within a word to access the Research pane. When you are online, you will instantly get a definition of the word.

Wordle – word cloud
Webnotes

 HYPERLINK "http://www.wordle.net/"
 Annotate the web.
Awesome Highlighter

 HYPERLINK "http://www.wordle.net/"
 - tool that highlights text on a web page; save the URL or email it
TheHeroFactory

 HYPERLINK "http://www.wordle.net/"
 (Design superheroes for stories)
Download Comic Life

 HYPERLINK "http://www.wordle.net/"
 (download) (Any teacher who is teaching writing concepts and wants to add a creative twist)
Story Creator

 HYPERLINK "http://www.wordle.net/"
 Any teacher who is looking for a creative way to inspire reluctant writers to create narratives
ePals  

 HYPERLINK "http://www.wordle.net/"
For teachers who want to encourage reading and writing while connecting their kids to kids around the world.  Available thru our Kan-Ed site.
fodey.com – newspaper generator

Math Tools

Math Playground - excellent site for Math activities for K-8, make sure to explore the Mathcasts which allow students to review math when THEY need to.

Thinking Blocks - a creative, interactive math resource to help students understand how to solve word problems. Watch the video here to learn how to use it.

GraphCalc - Online Graphing Calculator

National Library of Virtual Manipulatives - a library of uniquely interactive, web-based virtual manipulatives or concept tutorials, mostly in the form of Java applets, for mathematics instruction (K-12 emphasis)

Rainforestmaths - K- 6 interactive math activities (Mathletics)

Minyanland Game to help kids learn about money.

Math Lesson Creator (Any teacher looking for a tool to create new math lessons)

Math Snacks - (Any teacher who wants to let kids review key math concepts in a non-threatening way)

Science Tools

Celestia (free download) (For any teacher who is teaching space science or the solar system and wants to engage kids)

Study Skills Tools

CueCard - an electronic flashcard program download  with multiple features including ability to import audio and graphics. Keeps track of correct responses and can be printed out.

Study Stack - create interactive web-based flashcards or use ones that are already created; if you use stacks that are already created, check them first as there are errors in several of the created stacks.

Flash Card Machine - allows the user to create interactive web-based study flash cards.

Flash Card Friends - online, interactive flash cards

Quizlet - described as an online tool for learning vocabulary

Awesome Highlighter - tool that highlights text on a web page; save the URL or email it

muchobeets.com – create online flashcards

Free Collaboration Tools (these are accessible anywhere!)

Google Docs and Spreadsheets - allows students to collaborate on work from any computer including while at home

Zoho - full suite of online, collaboration tools - word processor, presentation, notetaking (can insert audio), spreadsheets, planner. Worth exploring!

Go 2 Web 2.0 - here you will find every Web 2.0 application imaginable. There are tools for everything. Constantly updated!  AMAZING !!

 Multimedia and Digital Storytelling Tools

Voice Thread - capture audio for online digital storytelling. THIS IS A MUST HAVE! The pro version is free to K-12 educators. WATCH THE EXPLANATION VIDEO – THE OPTIONS FOR THIS ARE LIMITLESS

Photo Story 3 for Windows - you will be amazed at how quickly you can create slide shows or movies from your class photos. Upload your photos in seconds, easily add music and you have a year end presentation of your class activities. MANY other uses.

ScrapBlog - Create online multimedia scrapbooks from your text, video, audio and photos

Computer Programming

Alice (Computer programming in a 3D environment)

Cooltext.com (Free "Graphics Generator" to make logos and website buttons; fun fonts you can download.)

gizmoz.com - Create your own avatars.

Audio

 Voice Thread  - capture audio for online digital storytelling

audacity.com – free recording program, great for developing podcasts

imeem.com – indie free music

Video

animoto.com - (For any teacher who wants to create of let kids create a quick video presentation.  Education account http://animoto.com/business/education)

Video Converters 

zamzar (Free online file conversion, turn that Youtube video into a video you can add to a

Kick Youtube (Teachers can convert Youtube videos into videos you can use)

Screencasting

Screen capture is easy, free and allows you to quickly create on-screen tutorials. Has many uses - instruction, professional development, reinforcement of concepts taught in class, etc.

Jing Screen capture software.  District has a subscription.

Screencast.com -  allows you to post your screen captures for others to view.

screencast-o-matic Screen capture

Discovery Education (United Streaming)   District has a subscription

Tuxpaint - 

 HYPERLINK "http://www.tuxpaint.org/"
Drawing program
camstudio

 HYPERLINK "http://www.tuxpaint.org/"
 - Free streaming video software
Bighugelabs _ 

 HYPERLINK "http://www.tuxpaint.org/"
cool tools for digital photos
Youtube - 

 HYPERLINK "http://www.tuxpaint.org/"
Video sharing, use w/ appropriate direction and supervision
Vuvox - 

 HYPERLINK "http://www.tuxpaint.org/"
Allows you to create interactive slideshows and presentations from photos, video and music from many sites
Ustream

 HYPERLINK "http://www.tuxpaint.org/"
 - free video broadcasting with embeddable player
Prezi

 HYPERLINK "http://www.tuxpaint.org/"
 - Zooming presentations, the District has a subscription
Photobucket - Free photo sharing.

Photostory 3
piclits.com – add commentary to pics
Pics4Learning - Free clipart and photographs for education.

Sumopaint - Online image editor with cool tool options

Slideshare - Share Powerpoints.

Goanimate - Create your own animated content for free

Image Mosaic Generator -(Recreate cool versions of pictures as mosaics)

Flickr - Photo sharing.

Mixbook - Create photo books online.

Snapfish – photobooks, etc., etc

movie maker (tutorial)

imagechef.com – photo editing: blending, framing, word mosaic in shapes (good), sketchpad

tiltshiftmaker.com – edit photos, focus on one area the rest is unfocused

stupeflix.com  video creator

flickr.com – photo sharing

fliggo.com – upload vids and create own sharing site

Podcasting

audacity (tutorial) (A tool for creating audio files that can be for local consumption or become podcasts)

Podcasting for Beginners

Audacity - free, open source software for audio editing;

    Basic Audacity Tutorial
    How-to-Guide for Podcasting with Audacity   watch the tutorial videos 

Seven things you should know about podcasting
Ten Benefits of Classroom Blogging
Copyright, Fair Use, Intellectual Property & Podcasting
 Introduction to Podcasting
Educational Podcasting Wiki - excellent resource

Podcasting Resource Toolbox - 70+ Tools
 Cell Phone Podcasting

 1.  Gcast 
2.  

 HYPERLINK "http://gabcast.com/"
Gabcast

 HYPERLINK "http://mashable.com/2007/07/04/podcasting-toolbox/"
 
Podbean Podcast hosting.

Podcast Alley Podcast hosting.

Podcast Pickle Podcast hosting.

Podomatic (A tool for creating and publishing podcasts)

Gabcast (A podcasting and audioblogging platform that offers an easy way to create and distribute audio content.)

itunes (download) Podcasts: (Any teacher who could use additional aligned curriculum resources in audio or video for their kids.)

Google Apps for Educators

    Google Docs in Plain English (video)

    Google for Educators - a  teacher’s guide to Google Tools for Your Classroom, as well as a number of additional tools

    Google Tools for Your Classroom - includes links to all google apps for educators as well as links to teacher created classroom activities

Teaching Collaborative Revision with Google Docs

 HYPERLINK "http://www.bloglines.com/"
- A Guide for Educators
Google Docs  (Let's you collaborate on documents in a word-like, excel-like environment)

Google Sketchup (Any teacher who wants to give kids a hands on experience while learning measurement, geometry concepts and creative design) (download)

googletimeline



Blogging - A blog is a social website where entries are written in chronological order and readers can leave comments.

Beginning Blogging for Educator – plus good resources
Educational Blogging Wiki - links to many education blogs

Blogging Sites, Ready to Begin? Start here  - EduBlogs, Class Blogmeister, WordPress, Blogger
Classroom Examples of Blogs in Action:

    First Grade Blog
    Fifth Grade Example
Videos about Blogging:

Telling the New Story - 1st Grade Teacher shares her views about using new tools, her students and parents share their thoughts as well.

posterous.com

 HYPERLINK "http://www.teachertube.com/view_video.php?viewkey=1486a538c0eaa45dd167"
 Microblogging made super simple
Wikis

Wikis in Plain English (video)
Wiki Collaboration Across the Curriculum by Vicki Davis - (27 minute long Video which demonstrates how to use wikispaces and discusses pedagogical uses of wikis)

Example of collaborative student wiki from schools throughout the country

Wiki sites to get you started - Wikispaces for Educators, PB Wiki for Educators, PMWiki, WetPaint Wiki
WetPaint Wikis in Plain English
Getting Tricky With Wikis

 HYPERLINK "http://www.bloglines.com/"
 - Learn a number of cool things you can do with your wikis.
Wetpaint.com - Create wikis for the classroom (Much content caution advised)

Social Bookmarking

Del.icio.us a social bookmarking tool that allows you to access and organize your favorites from any computer.  Offers collaboration between teachers, students and parents.

Del.icio.us Guide for Educators created by John Pedersen.

    To set up a delicious account:

Go to http://del.icio.us  

Click on "register".

Fill in username, full name, and password. (Hint: Choose a username and password that is easily remembered by you, Use the same username and password for all your applications.)

Click "register."

At a different computer, you will need to add a delicious button to your toolbar. 

Log in to delicious and your account.

Click on "settings" on the top right.

On the left sidebar, under "Settings" click the blue FAQs hyperlink.

Under "the posting buttons", click on "How do I install the buttons again, now that I'm using a different browser or computer?"

Follow the directions to load buttons onto your browser toolbar. Start at "Step Two of Installation" at the top of the page.

Click "tag" when you are on a website that you want to keep. If you tag using more than one word, do not put spaces between the words.  You can also bundle tags by categories.  Be sure to network to other people who would be interested in the same site. Use "delicious" when you want to quickly link to your account.
Music
Musescore

 HYPERLINK "http://www.bloglines.com/"
   Free music notation software
Impro-Visor

 HYPERLINK "http://www.bloglines.com/"
   Free music accompaniment software to improve improvising skills
imeem.com – indie free music
Professional Collaboration

Plurk(A way for teachers to build their own, custom support think-tank)

Skype (Any educator who wants to collaborate or let their students collaborate with authors, experts or other teachers and students in remote locations.)

21classes

 HYPERLINK "http://www.bloglines.com/"
 Free classroom and teacher blogs.
dropio.com – file storage and sharing
Additional Free Tools

Project Spectrum - Google Sketchup Tutorial for use with students on the Autism Spectrum

ZacBrowser - Web Browser designed by a grandfather for his grandson who is on the Autism Spectrum. Appropriate for young children or those with developmental disabilities

Yackpack - audio email or free live conferencing

Eyejot - video email tool

Better Fonts - Dafonts - downloadable fonts - real cheap

PDF Creator or Cute pdf - free PDF conversion tools

Diigo - a powerful social annotation research tool, with highlighting features

Cast UDL Lesson Builder - provides educators with models and tools to create and adapt lessons that increase access and participation in the general education curriculum for all students.

Checklists - linear alternative to rubrics, easily create guides for students' projects (PBL).

Visual Schedules – making schedules - best for younger students.

Imagine Symbols - 4000 free realistic symbols. Import these into your clip art folder for easy access.

Pics4Learning - copyright friendly image library for teachers and students

heromachine.com – create your own superhero in much detail

classmarker.com - Free quiz maker for online testing

goanimate.com – create your own animations

timetoast.com – cool timeline creator

freerice.com – toolbar that donates rice when used to search 

http://www.kwarp.com/portfolio/grammarninja.html  primary grammar site, good

Assorted Videos 

Teacher Tube Instructional Videos
Animal School video
Did You Know? video link
Did You Know 2.0? video
Connected Classroom video
Pay Attention
Tom Peters: Educate for a Creative Society
Sir Ken Robinson - Do Schools Kill Creativity?   Is YouTube blocked at your school?  Use Zamzar to download and convert videos at home which you can then show at school.  Better yet, talk to your IT staff about unblocking sites that you use for instructional purposes. 

SOCIAL  SOFTWARE 

The Three C’s – Connection, Collaboration, Coolness (Contagious!)

